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Preface
Thank you for choosing the product Tango TM by SINUS Messtechnik GmbH. Please read this manual
carefully before using the measuring system. We recommend you to perform several test measurements
to get familiar with the instrument before using it for important measuring tasks. The manual includes the
following signs to indicate important information:

NOTICE! These are information on the efficient use and correct handling of the ana-
lyzer as well as additional information.

CAUTION! These instructions shall avoid any hardware damages or dangers for users.

ATTENTION! These instructions shall avoid any measurement mistakes, hardware dam-
ages etc.

Please feel free to contact us for any questions on the functionality and operation of the instrument. Direct
your questions or catalogue requests as well as requests on spare parts and accessories to the following
address:

Address: SINUS Messtechnik GmbH
Föpplstraße 13
04347 Leipzig, Germany

Telephone: +49-(0)341-24429-33
Fax: +49-(0)341-24429-99
E-mail: info@soundbook.de
Web: http://www.soundbook.de
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1 GENERAL INFORMATION AND DESIGN

1 General information and design
TangoTM is an integrating sound level meter designed according to DIN EN 61672-1:2003, accuracy class 1
and group Z. This manual refers to firmware version 1.44.

NOTICE! Tango may perform measurements that require an official verification of the
calibration and that are legally binding.
(type approval number: 21.21/12.04)

ATTENTION! If Tango is used for legally binding measurements, only original accessories
shall be used.

For performing legally binding measurements with Tango only the following accessories are admitted ac-
cording to the type approval :

• Tango (907000.1)

• Calibrator Cal200 1/2” type1 PCB (800934.4)

• Calibrator Type 4231 B&K (800043.2)

• Windscreen W2 (800253.0)

Using Tango the following sound level values may be measured: LAF, LAFmax, LAFmin, LAS, LASmax, LASmin, LCpeak,
LAeq, LAtm, LAtm-LAeq, LAE, LCpeak>n und LAFn. A detailed description of these values is given in table 1.2.

NOTICE! The number of the firmware version can be displayed (section 2.3.2).

1.1 Important notes

When measuring with the device, please consider the following notes:

• Use the device as described in this manual only.

• Despite of its robust design, protect the device from any unnecessary bumps and vibrations as well
as humidity and dirt.

• Do not touch or moisten the sensitive microphone membrane during work.

• Pay attention to the permissible temperatures for using the device.

• Always switch off the device after using.

• Do not expose the device to excess temperature as for example in a car with direct sunlight.

• If necessary, clean the device carefully without using solvents.

• Do not disassemble the device. Do not try to repair the device in case of malfuntion. Such manipulation
will always cause the loss of warranty and major damages. Make a note of the occuring errors and
send us the device for repair.
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1.2 Power supply

1.2 Power supply

The device is powered by two batteries of the type LR6A (nominal voltage 1.2 . . . 1.5 V, primary cell or
rechargeable). Via the according USB cable Tango can be powered by an external source. Therefor the
cable has to be connected to a PC or to the public power supply via the provided adapter. The USB access
is totally separated from the internal batteries, so that the batteries are not affected, but accumulators are
not recharged, too. For legally binding measurements Tango has to be powered by battery, disconnected
from the public power supply.

1.2.1 Replace batteries

The battery compartment is located on the back at the bottom of the device (figure 1.1 bzw. 1.2). Follow the
instructions below to replace the batteries:

• Move up the lock of the battery compartment.

• Remove the lid.

• Remove the discharged batteries.

• Insert the new batteries paying attention to the polarity (figure 1.2)

• Switch on the device and check the battery status on the display (figure 1.3.2).

Figure 1.1: Closed battery compartment Figure 1.2: Open battery compartment
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1 GENERAL INFORMATION AND DESIGN

NOTICE! The device cannot be switched on without containing charged batteries,
i.e. you may not switch on the device connected to a PC via USB without
batteries.

ATTENTION! Changing the batteries causes loss of time and calibration data, if Tango is
not connected to external power supply at the same time.

1.3 Design

ATTENTION! For legally binding measurements Tango has to be powered only by battery.
The monitoring output is not approved for this.

Figure 1.3: Design of the device

Tango contains the following parts: de-
tachable microphone with preamplifier, cas-
ing, display, keypad and battery com-
partment. Opening the device is only
necessary for replacing the batteries (fig-
ure 1.2.1).

At the bottom of the device the USB
socket is located for connecting the de-
vice to a PC (type mini five-pole). Next
to it there is a socket for a 3.5 mm
stereo jack. This monitoring output is used
to connect a headset for example, it is
not approved for legally binding measure-
ments.

A detailed description of the display and key-
pad is given in the paragraphs 1.3.2 and 1.3.1.
Pay also attention to the notes given in para-
graph 1.1.

Manual Tango 8 of 34 SINUS Messtechnik GmbH



1.3 Design

1.3.1 Keypad

If the device is not controlled via PC, you may also use the keypad for setup. Details on operating the device
with the keypad are given in section 2.3.2.

Key Name Description

Stop-Button Stop measurements.

Play/Pause-Button Start/pause/continue measurements. However, data is only saved if the Record-Mode is active.

Scroll-Button Change displayed value according to the boxes marked with * in figure 2.2.

OK-Button
Confirm settings in the Setup-Mode. This key is only used in this mode, therefore it is not
described in detail.

Setup-Button Switch between Display-Mode and Setup-Mode.

Record-Button (De)-Activate the Record-Mode.

Mark-Button

If pressed during a measurement, a mark is saved for the corresponding time interval. This
mark may be captured by the software and represented in the level vs. time history. If the
device is in Pause-Mode, the last five seconds of the measurement may be deleted by pressing
the Mark-Button (back-erase feature).

On/Off-Button
Switch on/off device (key press > 3 seconds)
Switch on/off backlight (short key press)

Table 1.1: Description of keys/buttons

1.3.2 Display

The diplay shows the measured values and is used for setting up the device. It is refreshed every 500 ms.
The individual sections of the display are described in the following paragraphs.

Figure 1.4: Display of the device
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1 GENERAL INFORMATION AND DESIGN

Battery symbol

The symbol on the display shows the battery status. The following three stauses may be displayed:

• The battery is fully charged. A legally binding measurement may be performed.

• The battery is charged half. A legally binding measurement may be performed.

• The battery is discharged. A legally binding measurement may not be performed. The device will
automatically turn off if the batteries are not replaced.

1.4 Software installation

First Tango driver must be installed for that Tango is recognized via USB connection. Second Tango-Utilities
should be installed for configuration of Tango settings and export of data.

1.4.1 Tango driver installation

Please follow the instructions below to install the SINUS driver on a PC. You find the file on the enclosed CD
or on the installation CD of the application software. Use the Windows Explorer to start the driver installation
programme. Perform the install setting and confirm always. Depending on the system performance this
procedure may take a few minutes.

1.4.2 Tango-Utilities installation

Installing the software Tango-Utilities resembles the installation procedure of most Windows applications.
Follow the instructions below:

• Run the installation program (Tango_Utilities_Version.exe).

• The first window shows the software version. Click on Next to continue to the next window.

• Set the installation directory in the next window. Click on Next to continue to the next dialog.

• In this dialog you may specify the directory in the Windows Start Menu. Click on Next to continue to
the next dialog.

• This dialog summarizes your settings. Click on Install to confirm these and to continue to the next
dialog.
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1.5 Calculated values

• Finish the installation by clicking on Finish .

1.5 Calculated values

Level Description

LAF Sound pressure level, frequency weighting A, Fast (125 ms time constant)

LAFmax Level maximum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data).

LAFmin Level minimum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data). This
value is only available by Tango-Utilities.

LAS Sound pressure level, frequency weighting A, Slow (1 s time constant)

LASmax Level maximum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data).

LASmin Level minimum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data). This
value is only available by Tango-Utilities.

LCpeak Peak value of the C-weighted sound pressure level

LAeq Equivalent continuous sound pressure level for the entire measuring period (on the display) or of the last storing
interval (stored data), frequency weighting A.

LAtm Equivalent continuous sound pressure level calculated from the Taktmaximal levels during the entire measuring period
according to DIN 45645-1, maximum sound pressure level of the last 5 s.

LAtm - LAeq Difference of the values LAtm and LAeq

LAE Sound exposure level, frequency weighting A

LCpeak>n Time in which the LCpeak exceeded n dB.

LAFn Percentile levels can be calculated from the LAF (n = 1, 2, 3). Data can be stored up to an amount of 8 MB. There are
7 standard percentiles (1, 5, 10, 50, 90, 95, 99).

Table 1.2: Calculated sound levels

NOTICE! All sound level values may only be reset by manual Start/Stop operation
and the integration time for the equivalent continuous sound pressure levels
may only be set with this operation.

NOTICE! All integrated sound levels listed in table 1.2 will be displayed on the device
immediately after finishing a measurement/integration.
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2 APPLIANCE

2 Appliance
2.1 General information

Tango offers different operating modes:

OFF The device is off and no measurements can be performed. Only the clock is running inside.

Stop The device is running. The LAF and the LAS are measured and displayed, if these values have been
selected for display. With the Record button is defined whether the data of the next measurement
should be stored. If yes, the circle symbol must be displayed.

Run The device is on and measuring ( is blinking). If data recording has been activated, data will be
stored ( is blinking). You may read the instantaneous measurement values on the display and move
between the values using the Scroll-Button.

Pause A running measurement is paused ( is displayed) and so the measuring time. The measurement
can be stopped or proceeded any time.

Display Description

The device is in Pause-Mode. The measurement has been paused and the measuring time
has been stopped.

Data recording is active. The measured data will be stored in Run-Mode.

The device is in Run-Mode (Symbol blinks). The measurement has been started. If data
recording is active, the measured data are stored. If data recording is inactive, no data will
be stored.

Table 2.1: Display of run modes

2.2 First use

Pay attention to the following notes before using the device for the first time:

• Read carefully the manual and follow the instructions before using the device!

• Insert the batteries as described in paragraph 1.2.1.

• Install the required software on a PC (driver and Tango-Utilities).

• Connect the device with the PC using the supplied USB cable.

• Switch on the device by pressing the On/Off-Button (minimum 3 seconds, see table 1.1).

2.3 Device configuration

You may configure the device via PC using the software Tango-Utilities or manually.

2.3.1 Configuration using Tango-Utilities

For configuring the device via PC, you have to install drivers and Tango-Utilities software first (section 1.4).
Possible settings in Tango-Utilities are adjusted in the Setup tab.
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2.3 Device configuration

Figure 2.1: Tango-Utilities- Setup Tab

Use the check boxes in the column Display to (de-)select individual values for display on the device and on
your PC. Several values offer optional parameters, which you may set in the column Options. By the buttons
Open and Save you may open a configuration from the PC or save the current one to it. The same can be
done by using the menu points File → "‘Open Configuration"’ and File → "‘Save Configuration As"’.
The current configuration is transmitted to Tango by clicking on Apply .

In the column Storage the correspondig storage conditions are adjusted. The storage can be turned off,
limited to one finish result or done in regular intervals. For the interval time span several values are provided
from 62, 5 ms up to 60 min depending on the measurement value. Even if the interval storage is selected
a finish result over the whole measurement time is calculated and stored additionally. This would always be
saved, even if the intervall storage would have been aborted because of full memory. In this case the record
symbol would stop blinking.

NOTICE! For the interval storage of the percentiles only the same interval time span
can be selected.

If Synchronisation is enabled, the interval storage will be synchronised with the full hours of day time. So
every full hour the current interval is closed and a new one is started. The clock is set every time, when
connecting Tango to Tango-Utilities.
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2 APPLIANCE

2.3.2 Manual configuration

The manual configuration of the device without PC is shown in the following diagram (figure 2.2):

Figure 2.2: Configuration menu

Press the Setup-Button to toggle between Display- and Setup-Mode. The first menu item in the Setup-Mode
is Calibration (for details see section 2.6). Use the Scroll-Button to move between the items of the individual
menu. Press the OK-Button to open the corresponding sub-menu. During configuration the parameter which
is being adjusted is blinking. In figure 2.2 the blinking is represented by .

The firmware version is displayed as long as the Setup button is pressed at the same time Tango is switched
on.
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2.4 Tango-Utilities

2.4 Tango-Utilities

The structure of Tango-Utilities resembles that of other Windows applications. It contains a main menu, a
working section and a status bar (see following figures). In the main menu you may select various items (e.
g. Firmware Update, Program Settings, Save as). You may view the software version of Tango-Utilities
in the main menu selecting Help -> About (figure 2.4). The firmware version of the dive is displayed in the
Info-Tab (figure 2.3).

Figure 2.3: Tango-Utilities - Info Tab Figure 2.4: Tango-Utilities - About-Box

NOTICE! Using Tango-Utilities you can adjust all settings. Configuring manually
you may only adjust a restricted selection of parameters.

2.4.1 Setup-Tab

In the Setup tab the configuration is done with Tango-Utilities (section 2.3.1).

The status bar displays various status information from left to right:
Connection Status: disconnected, connected, but Tango off, connected, Tango on;
Virtual COM Port; Measurement Status;

Record Status: Record-Mode off, Record-Mode on,
blinken←→ Record-Mode on (Recording);

Marker Status: MARK; Storage Requirement/(Overflow Underrange)/Storage Status.

Program settings

Via the main menu Settings->Program. . . the following settings are available (figure 2.5.): selection of the
connected device Tango (Connected Device), default export directory (Default Export Directory) and the
default directory for configuration data.

Extended device settings

NOTICE! The changes you apply will be saved on the device until you adjust them
again using Tango-Utilities.
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2 APPLIANCE

These settings cannot be adjusted manually without PC.

Parameter Description

Disable Device Calibration Select this parameter to disable calibration feature on the device.

Disable display setup changes Select this parameter to lock the display settings.

Disable measurement setup changes Select this parameter to lock measurement recording settings.

Enable fixed record mode Select this parameter to activate the Record-Mode permanently.

Enable backlight permanently Enables background light of the display permanently.

Startup after battery replacement Automatic start of Tango after changing the batteries.

Table 2.2: Extended progam settings

Figure 2.5: Tango-Utilities - Program settings Figure 2.6: Tango-Utilities- Extended device settings

2.4.2 Display-Tab

In the Display-Tab the values are shown, which are calculated by the device during a measurement (accord-
ing to the settings in the Setup-Tab). On the left side you will find a table of values which are available for
display in the graph on the right side.

Figure 2.7: Tango-Utilities- Display Tab
Figure 2.8: Tango-Utilities - Graph
Properties
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2.4 Tango-Utilities

To select a value for graphical display click on the individual values in the header of the graph. You may
select a maximum of four values for simultaneous display. You may change the axis settings by right-clicking
on the graph. A context menu will open in which you will find the item Properties. A click on this item will
open the window in figure 2.8. The context menu also contains controls for zooming in and out.

2.4.3 Data-Tab

On the right side of the Data-Tab a table containing the recorded data is displayed. On the left side a
summary of the selected measurement is displayed. By right-clicking on an entry in the table you will open
a context menu in which you may delete the measurement (Delete) or save data to the PC (Export).

Figure 2.9: Tango-Utilities - Data Tab

2.4.4 Data export

Measured data are saved to the internal storage of the device (8 MB). The data sets are listed in the Data-
Tab (section 2.4.3). By right-clicking you may open a context menu. The item Save as may be used to
export/store data to the PC. Specify the name of the file containing the final values of a measurement in the
Result tab(figure 2.10).

Specify the name for the file containing interval values in the other tabs, csv compatible with Excel (fig-
ure 2.11) or smr compatible with Auditor. This tabs also include two lists. The left list shows the values which
are part of the measurement, but which have not been selected for export yet. The right list shows the val-
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2 APPLIANCE

ues which have been selected for export already. To add or remove values from these lists use the buttons
Include and Exclude . To add new files for export use the button Add File , to remove files use Remove File .

Figure 2.10: Tango-Utilities - Export window 1 Figure 2.11: Tango-Utilities- Export window 2

Measurement file: File7

Start time: 02.06.2009 08:45:09

Duration: 2:57

Overflow: no

Underrange: no

LAFmax: 77,4 dB

LASmax: 68,5 dB

LCpeak: 103,3 dB

LAeq: 48,4 dB

LAE: 70,9 dB

LAtm5: 62,7 dB

LAtm5-LAeq: 14,3 dB

LCpeak >90dB: 0:01 min:sec

LCpeak >135dB: 0:00 min:sec

LCpeak >140dB: 0:00 min:sec

LAF90: 40,3 dB

LAF95: 40,0 dB

LAF99: 39,7 dB

Figure 2.12: Tango-Utilities - Example Result.txt from
fig. 2.10

Figure 2.13: Tango-Utilities- Example Filename_1.csv

from fig. 2.11

2.5 Measure

For legally binding measurements the device must run on batteries/rechargeables. Therefore the device has
to be controlled with the keypad. Follow the instructions below to perform a binding measurement:

1. Position the device (held in the hand or mounted upon a tripod).

2. Switch on the device.

3. Check the battery charge status (see paragraph 1.3.2).

4. Use the Record-Button to enable/disable data recording.

5. Press the Start-Button to start the measurement.

6. Press the Stop-Button to stop the measurement.
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2.6 Calibrate

2.5.1 Measure low sound levels

You do not have to make special preparations for measuring low level sounds.

2.5.2 Overload and Underrange

The display for overload and underrange is arranged left and right of the bar graph (figure 1.4). It is displayed,
when the linearity range is left. The representation on the display is explained in the following table 2.3.

Tango-Utilities Display Description

No overload has occured in current measurement.

Overload has occured in current measurement.

Currently an overload occurs.

No underrange has occured in current measurement.

Underrange has occured in current measurement.

Currently an underrange occurs.

Table 2.3: Display of overload and underrange

NOTICE! A reset of the overload or underrange display is only possible by stopping
and restarting the measurement.

2.6 Calibrate

A list of the approved calibrators and the accuracy classes achieved is given in section 5. Follow the instruc-
tions below to calibrate the device at 1 kHz:

2.6.1 Calibrate using Tango-Utilities

1. Connect Tango to the PC.

2. Start Tango-Utilities.

3. Insert the microphone into the calibrator and activate the calibration signal. The reference calibration
level is 94 dB for this methode.

4. Press the CAL button in Tango-Utilities. “Calibration activated” appears in the status bar. To cancel
the calibration procedure, press the stop button.

5. Having finished you are asked to adopt the new calibration values. If something went wrong, an error
message appears.

2.6.2 Calibrate Tango directly

1. Switch on the device.

2. Press the Setup-Button. The configuration menu will be displayed (figure 2.2) and is blinking.

3. Press the OK-Button. The reference calibration level will be blinking on the display (e.g. 94 dB). You
may adjust this value with the Scroll-Button (94 dB, 104 dB or 114 dB).

4. Switch on the calibrator (select the correspondig level on the calibrator, if necessary) and insert the
microphone into the calibrator.
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2 APPLIANCE

5. Press the OK-Button. Calibration starts. First, the noise level of the device is measured and second
the calibrator signal. During calibration, is blinking on the display. When stops blinking, the
calibration is finished. The measured level is displayed enabling you to check the calibration result.

6. Press the OK-Button to save the new sensitivity value or press the Setup-Button to reject.

7. You have left the calibration menu and the device is in STOP-Mode.

If the calibration has been affirmed the symbol is shown on the display until the next start of Tango. The
calibration data is stored until the next change of the batteries. This will reset Tango to factory defaults.

NOTICE! If the new value deviates more than 3 dB from the old one, it is not ac-
cepted. The message “Error” is displayed in this case.
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3 Testing information
3.1 Acoustic test

3.1.1 Microphone alignment for measuring the influence of mechanical vibrations accord-
ing to DIN EN 61672-1:2003.

For this test you need a second sound level meter with officially verified calibration as reference device.
The microphone of the reference device has to be positioned in a maximum distance of 0.2 m from the
microphone of the tested device and must not be exposed to the mechanical vibrations of the exciter.

Figure 3.1: Alignment for vibration test

3.2 Electrical test

For eletrical testing use the equivalent electrical impedance device K65 only (section 5) (manufacturer spec-
ifications: 22 pF ±12% with a parallel resistance of 81 MΩ ±12%).

3.2.1 EMC test

The measurement is performed for the following configurations:

Low interference immunity: USB cable linked to public power supply and microphone extension cable
connected

Maximim interference immunity: USB cable and microphone extension cable disconnected

3.2.2 Level linearity

The starting values for the level linearity tests are listed in the last column of table 4.3.
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4 TECHNICAL SPECIFICATIONS

4 Technical specifications

Property Value

Software Tango-Utilities

Number of channels 1

Accuracy Class 1 according to DIN EN 61672-1:2003

Display of measured values LCD display

Frequency weighting A, Cpeak (simultaneously), no optional frequency weightings

Time weighting Fast, Slow, Peak (simultaneously)

Data storage Yes

Self-generated noise ≤19 dB(A)

Max. Sound Pressure Level see table 4.5

Linearity range 25. . . 140 dB(A) (at 1 kHz)

Nominal measuring range for LCpeak 37. . . 140 dB(C)

Max. electr. measuring range ± 2 V

Max. input voltage at
the input of the feeding device

± 2,5 V

Umax at input ± 2,5 V

Integration response immediate

Time weighting F Rise or decay time constant = 0.125 s

Time weighting S Rise or decay time constant = 1 s

Time weighting Peak Rise time constant = 20 µs

Shortest integration time 16 ms

Longest integration time 194 days (100 h running on rechargeables)

Interfaces USB

Stabilizing time after switch-on 1 min

Warm-up time 1 min

Calibration frequency 1 kHz

Max. time of day drift max. 1.73 s in 24 h

Battery 2xLR6A, >100 operation hours without display backlight

External power supply via USB (see accessories)

Dimensions 266 mm x 76 mm x 38 mm

Weight 320 g (batteries inserted)

Reference conditions

Reference direction Along the microphone axis

Reference sound pressure level 94 dB

Reference frequency 1 kHz

Reference measuring range 25. . . 140 dB(A)

Reference air temperature 23 ◦C

Reference air pressure 101.325 kPa

Reference relative humidity 50 %

Table 4.1: Technical data Tango
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4.1 Level linearity range

4.1 Level linearity range

The following table 4.2 contains the measurement ranges for A-weighted sound levels and the C-weighted
peak sound level.

Fast/Slow/Leq dB(A) LAE dB(A) LCpeak dB(C)

25. . . 140 ab 30 37. . . 140

Data in dB and for a mircophone sensitivity of 50 mV/Pa

Table 4.2: Level linearity ranges for A-weighted sound levels

4.2 Linear operating ranges

The operating ranges given below are only valid for calibrated devices! The last column shows the starting
values for the level linearity tests.

f max in dB(A) min in dB(A) Range in dB(A) Starting values

16 Hz 84 30 54 74

31,5 Hz 100 30 70 84

1 kHz 140 25 115 94

4 kHz 141 30 111 94

8 kHz 140 30 110 94

12,5 kHz 137 30 107 94

Table 4.3: Linear operating ranges (f is the frequency of the sine burst.) and starting values for the level linearity tests.

4.3 Self-generated noise

The self-generated electrical noise of the device including preamplifier (measured with equivalent electrical
impedance and 50Ω at the input) amounts to approx. 16 dB(A) on the display. The acoustic noise is 16 dB.
This is a total noise level of 19 dB. The highest noise level may be expected when externally powered.

ATTENTION! Legally binding measurements must not be performed, if the device is con-
nected to public power supply.

4.4 Details on EMC

When the device is exposed to electromagnetic emissions the lower limits of the ranges in table 4.2 are
increased by 5 dB. Within these changed ranges the error limits according to DIN EN 61672-1:2003 are
maintained. The level linearity range changes to 40. . . 107 dB(A) when the device is exposed to electro-
magnetic emissions. There will be no performance loss in the device after electrostatic discharges (touch
discharge up tp 4 kV and air discharge up to 8 kV).
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4 TECHNICAL SPECIFICATIONS

4.5 Frequency weighting

f A Tango C Tango A Standard C Standard Diff A Diff C

10 -67,93 -13,76 -70,00 -14,30 2,07 0,54

12,5 -62,56 -10,84 -63,40 -11,20 0,84 0,36

16 -55,90 -8,12 -56,70 -8,50 0,80 0,38

20 -50,00 -5,94 -50,50 -6,20 0,50 0,26

25 -44,54 -4,20 -44,70 -4,40 0,16 0,20

31,5 -39,36 -2,90 -39,40 -3,00 0,04 0,10

40 -34,36 -1,88 -34,60 -2,00 0,24 0,12

50 -30,14 -1,22 -30,20 -1,30 0,06 0,08

63 -26,12 -0,78 -26,20 -0,80 0,08 0,02

80 -22,32 -0,46 -22,50 -0,50 0,18 0,04

100 -19,06 -0,28 -19,10 -0,30 0,04 0,02

125 -16,12 -0,18 -16,10 -0,20 -0,02 0,02

160 -13,22 -0,10 -13,40 -0,10 0,18 0,00

200 -10,82 -0,06 -10,90 0,00 0,08 -0,06

250 -8,66 -0,04 -8,60 0,00 -0,06 -0,04

315 -6,62 0,00 -6,60 0,00 -0,02 0,00

400 -4,74 0,00 -4,80 0,00 0,06 0,00

f A Tango C Tango A Standard C Standard Diff A Diff C

500 -3,22 0,00 -3,20 0,00 -0,02 0,00

630 -1,92 0,00 -1,90 0,00 -0,02 0,00

800 -0,78 0,00 -0,80 0,00 0,02 0,00

1000 0,00 0,00 0,00 0,00 0,00 0,00

1250 0,58 -0,06 0,60 0,00 -0,02 -0,06

1600 0,98 -0,06 1,00 -0,10 -0,02 0,04

2000 1,20 -0,18 1,20 -0,20 0,00 0,02

2500 1,28 -0,28 1,30 -0,30 -0,02 0,02

3150 1,26 -0,40 1,20 -0,50 0,06 0,10

4000 1,10 -0,68 1,00 -0,80 0,10 0,12

5000 0,78 -1,06 0,50 -1,30 0,28 0,24

6300 0,20 -1,64 -0,10 -2,00 0,30 0,36

8000 -0,60 -2,46 -1,10 -3,00 0,50 0,54

10000 -1,74 -3,62 -2,50 -4,40 0,76 0,78

12500 -3,30 -5,14 -4,30 -6,20 1,00 1,06

16000 -5,48 -7,32 -6,60 -8,50 1,12 1,18

20000 -7,90 -9,74 -9,30 -11,20 1,40 1,46

Table 4.4: A- and C-weighted frequency response

Figure 4.1: A-weighted frequency response

Figure 4.2: C-weighted frequency response
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4.6 Microphone

4.6 Microphone

Only the original microphone capsule MK255 by MICROTECH GEFELL is approved for measurements with
Tango. The directional characteristics of the microphone correspond to the limits specified in DIN EN 61672-
1:2003. The effect of the windscreen on the directional characteristics of the microphone is negligible. As
a result all corresponding correction values are specified with pm0.1 dB. The acoustic center point and
microphone reference point are located at the middle of the microphone membrane.

Property Value

Model Transducer type Capacitive pressure transducer

Polarization backelectret

Frequency range free-field 3.5 Hz . . . 20 kHz (±2 dB)

Sensitivity ca. 50 mV/Pa

Max. SPL for 3 % , distortion at 1 kHz 146 dB

Self-generated noise with preamplifier 15 dBA

Capacitance 17 pF

Operating temperature range -50 . . . +100 ◦C

Ambient temperature coefficient leq0.01 dB/◦C

Ambient pressure coefficient -0.01 dB/kPa

Diameter 1/2”

with protection lid 13,2 ± 0,02 mm

without protection lid 12,7 ± 0,02 mm

Length 16,4 mm

Weight 7,5 g

Thread for preamplifier 11,7 mm 60 UNS

Thread for protection 12,7 mm 60 UNS
Table 4.5: Technical data MK255

4.6.1 Random incidence and free-field correction

f Freifeldkorr. Diffusfeldkorr.

in Hz in dB in dB

25 0 0

31.5 0 0

40 0 0

50 0 0

63 0 0

80 0 0

100 0 0

125 0 0

160 0 0

200 0 0

250 0 0

315 0 0

400 0 0

500 0 0

630 0 0

f Freifeldkorr. Diffusfeldkorr.

in Hz in dB in dB

0.8 k 0 0

1 k 0 0

1.25 k -0.03 0

1.6 k 0.03 0

2 k 0.21 -0.1

2.5 k 0.36 -0.1

3.2 k 0.56 0

4 k 0.88 0.1

5 k 1.36 0.2

6.3 k 2.01 0.4

8 k 2.99 0.7

10 k 4.25 0.9

12.5 k 6.14 1.8

16 k 8.77 3.4

20 k 9.9 3.2

Table 4.6: Free-field and random incidence corrections (manufacturer’s specification: measurement uncertainty at 95% certainty ±0.6 dB)
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4 TECHNICAL SPECIFICATIONS

4.6.2 Directional characteristics

Figure 4.3: Mikrofonachse
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4.7 Effect of environmental conditions
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4.6.3 Frequency response of the microphone
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4.7 Effect of environmental conditions

In order to avoid the effect of sound reflections from the body of the operator interfering with the mea-
surement, Tango should be located as far as possible from the body. Thus, when actually performing the
measurement, the operator should place himself at a distance behind the tripod-mounted meter, or extend
the hand-held meter as far from the body as is comfortable.

Property Value

Temperature Calibration deviation < 0,3 dB within a temperature range from -20 ◦C to + 50 ◦C and at a relative
humidity of 65 %

Humidity calibration deviation < 0,1 dB within a humidity range from 25 % to 90 % and at a temperature of 40
◦C

Pressure calibration deviation < 0,1 dB within a range from 65 kPa to 108 kPa

Magnetic fields A field of 80 A/m (50 Hz) causes a reading of < 28 dB(A)

Vibration see paragraph 4.7.2

Storage conditions -20 ◦C . . . +60 ◦C, humidity max. 95 %

Electromagnetic compatibility

Emission complies with EN 50081-1 (1992)

Immunity complies with EN 50082-1 (1997)

Table 4.7: Environmental conditions for the device
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4 TECHNICAL SPECIFICATIONS

NOTICE! When the temperature changes by more than 15 ◦C an acclimatization time
of 30 min must be safeguarded.

4.7.1 Mains frequency and high-frequency fields

Tango complies with DIN EN 61672-1:2003 with respect to interference immunity to mains frequency and
high-frequency fields. The interference immunity to mains frequency and high-frequency fields is highest
when the device is running on batteries/rechargeables without USB cable connected.

If Tango is connected to a PC and measuring high-frequency emissions are highest. Additionally, the inter-
ference immunity to mains frequency and high-frequency fields is lowest in this configuration (alignment see
fig. 4.4). The next lowest emission level is reached in the same configuration, but in STOP-Mode.

In compliance with paragraph 6.6.9 of DIN EN 61672-1:2003 Tango is not appropriate to measure levels
lower than 74 dB for an electric field strength exceeding 10 V/m.

Figure 4.4: Alignment measurement HF immunity

4.7.2 Effect of mechanical vibration

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 perpendicular to the mem-
brane plane of the microphone, the lower limit of the linear operating range increases to 75 dB for the
frequencies 31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.
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4.8 Connection assembly of the detachable microphone

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 parallel to the membrane
plane of the microphone, the lower limit of the linear operating range increases to 58 dB for the frequencies
31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.

4.8 Connection assembly of the detachable microphone

ATTENTION! The detachable microphone must be used only with Tango! Otherwise it
may be damaged.

Figure 4.5: Pin assignment for the detachable microphone

The microphone of Tango is detachable
and connected to the analyser via LEMO
FGG.1B.307. The pin assignment is shown in
figure 4.5.
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5 ACCESSORIES

5 Accessories
Tango achieves accuracy class 1 of DIN EN 61672-1:2003 in all possible device-accessories-alignments
without the necessity of applying any correction values.

Accessory Manufacturer Item number

Cal200 PCB, 1 kHz, 94 dB or 114 dB 800934.4

Type 4231 B&K, 1 kHz, 94 dB bzw. 114 dB 800043.2

Windscreen W2 MICROTECH Gefell 800253.0

USB cable A-Bmini 5 Pol 1.8 m SINUS Messtechnik GmbH 801038.7

USB power supply adaptor SINUS Messtechnik GmbH 601092.6

Equivalent electrical impedance K65 MICROTECH Gefell 800030.3

Table 5.1: Available accessories for Tango

The Windscreen W2 is black coloured and spherically with a diameter of 69 mm.

5.1 Technical specifications of the calibrators

Feature Value

Standards IEC 60942:2003 and
ANSI S1.40-1984, Class 1

Sound pressure level 94 dB, 114 dB ±0.1 dB

Supported microphone types 1/2”, 1/4”, 3/8”

Weight 156 g

Sound pressure stability <0.1 dB

Surrounding conditions each for ±0.3 dB tolerance

Static pressure 65 kPa . . . 108 kPa

Humidity 10% . . . 90% RH

Temperature -10 ◦C . . . + 50 ◦C

Table 5.2: Technical specifications Cal200

Feature Value

Standard IEC 60942:2003, Klasse 1

Sound pressure level 94 dB, 114 dB ±0.2 dB

Supported microphone types 1”,1/2”

Weight approx. 150 g

Sound pressure stability <0.05 dB

Surrounding conditions

Static pressure 65 kPa . . . 108 kPa

Humidity 10 % . . . 90 %RH

Temperature -10 ◦C . . . + 50 ◦C

Table 5.3: Technical specifications Type 4231

5.2 Tango Outdoor kit

With the optional outdoor kit Tango can be used as temporary monitoring station for environmental noise.
The runtime from the external battery depends on the measurement configuration, a typical value is 2 month.
The data are stored locally. The following items are included in the outdoor kit (figure 5.1):

• Peli Case 1500 with foam insert and LEMO7 Cable intern

• V-Mount Li-Accu 14.8V/6.1A

• BSV1TV Li-Ion Travel Charger

• DC/DC-Adapter

• LEMO7 Extension Cable 3m

• WS1 Microphone Weather Protector

• Tripod
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5.2 Tango Outdoor kit

Figure 5.1: Optional accessorie “Outdoor kit” (Tango itself not included)
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6 APPROVED FUNCTIONS CONCERNING LEGALLY BINDING MEASUREMENTS

6 Approved functions concerning legally binding mea-
surements

The following functions are approved:

• Start/Stop/Pause function (section 1.3.1)

• Sound levels (table 1.2 in section 1.5)

– Taktmaximal level

– Percentile levels: LAF90, LAF95, LAF99

– Time weightings (Fast, Slow, Peak)

– Frequency weightings (A, Cpeak)

– Level linearity

– Inherent noise level

• Kalibration (section 2.6)

• Overload (section 2.5.2)
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7 Declaration of Conformity
We, SINUS Messtechnik GmbH, Foepplstrasse 13, 04347 Leipzig, Germany, declare that the product

Sound Level Meter Tango
Part Number: 907000

Serial Number:

to which this CE-declaration relates, is in conformity with the following standards and other documents:

Technical Parameters Sound Level Meter: IEC 61672 or DIN EN 61672 class 1
DIN 45657

Electromagnetic Compatibiliy: Emission IEC 61000.6.3 or DIN EN 61000-6-3
IEC 61672 or DIN EN 61672

Immunity IEC 61000.6.2 or DIN EN 61000-6-2
IEC 61326 or DIN EN 61326
IEC 61672 or DIN EN 61672

Safety IEC 61010.1 or DIN EN 61010-1

The measuring system is intended for use with measuring microphones according to IEC 1094-1. This prod-
uct has been manufactured and tested in compliance with the following binding internal documentation from
SINUS Messtechnik GmbH:

Manufacturing and Testing documents: - Quality assurance manual
- Manufacturing documents for Tango
- Testing rules for Tango

This product was tested and found to comply with all specifications.

Gunther Papsdorf
Managing Director
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